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----------------------------------------------------------------------ABSTRACT-------------------------------------------------------------- 

Nowadays there are many blind assistive systems but there is no such kind of stick that will navigate to a blind person and 

also to guide him each & every movement that can help to rescue him/her in any panic situation.  In this paper, we have 

presented a artificial vision stick with hurdle recognition, that is voice based via GPS along with panic alert system. In this 

system blind person is navigated through a spectacle interfaced with an android application. The blind person is guided 

using three languages such as  Hindi, Kannada, and English voice commands generated by the application according to the 

obstacle position that helps the blind person to go anywhere in the world. With the help of voice command a blind person 

can establish voice call to an authorized person  without touching the phone just by pressing the headset button. The blind 

assistive application gets the latitude and longitude values using GPS and then sends them to a server. The movement of the 

blind person is tracked through another android application that points out the current position in Google map. The basic 

objective of the system is to provide a artificial vision stick by providing information about the environmental scenario of 

static and dynamic objects surrounding him. 

 

Keywords - Arduino, sensors like (ultrasonic, water, flame) and jumper wires for connection, GPS, artificial vision  

                   stick. 

 
 

  

I. INTRODUCTION 
 

According to Aristotle, our knowledge about the outside world 

depends on five sense organs. As vision is one of the most 

important sense organ of human that gets from the environment 

via sight. According to the World Health Organizations (WHO) 

of 2010, over 285 millions peoples in the world are visually 

challenged and of whom 39 millions are blind and 246 millions 

have moderate to severe visual impairment. In India about 21.5% 

of the total number of visually impaired with 53 millions of 

citizens are suffering from some of visionless. Blind people face 

several problems in their life, one of these problems that is the 

most important one is detection the obstacles when they are 

walking. In India 21.5% of the total number of visually impaired 

with 53 million citizens suffers from some form of visionless. 

Globally uncorrected refractive errors are the main cause of 

moderate and severe visual impairment; cataract is the leading 

cause of blindness in middle and clone income countries. 

According to the World Health Organization, approximately 

0.4% of the population is blind in industrialized countries while 

the percentage is rising to 1% in developing countries. The main 

aim of the project is to design a voice based alerting system for 

the blind people. Ultrasonic Sensor senses the obstacles in its 

path by continuously transmitting the ultrasonic waves. The 

controlling device of the whole system is a Microcontroller and 

this system is very helpful for blind people. For blind person a 

greatest challenge is that blind person has to rely on other. The 

simplest and most widely used travelling aid used by all blinds is 

the white cane. It has provided those people with a better way to 

reach destination and detect obstacles on ground, but it cannot 

give them a high guarantee to protect themselves from all level 

of obstacles. Sometimes it happens that blind people are lost and 

their guardians are in tension about them. There have been many 

efforts but even now, it is not easy for the blind people to move 

independently from one place to another. In this system the 

modified electronic components and sensors. The ever growing 

and technology and with recent developments can help in 

artificial and accurate navigate this model uses ultrasonic sensor 

for hurdle detection and Wi-Fi routers are installed in every bus 

stops; where the buses bus stops names are informed or notified 

through the earphone. The blind people also face the problem 

they cannot afford the dogs for guidance because of high cost for 

dogs. The blind people also face the problems to identify the 

objects in house like kitchen tools, cloths and other important 

things. They also face the problem while handling the electronic 

and electrical devices which can harm them. The project can 

reduces these kinds of problems of blind person. 

II. LITERATURE  SURVEY 

The aim of this research is to provide a good understanding to 

make a suitable system in the future. In [1], the authors have  

proposed a system, & named Smart Vision, whose 

objective is to give blind users the ability to move 

around in unfamiliar environment, whether indoor or 

outdoor, through a user friendly interface. They 

focused mainly on the development of the computer 

vision module of the Smart Vision system. This system is 

specially designed to protect the area near to blind person  head. 

The product is designed to provide full navigation to user into 

the environment. It guides the user about obstacles as well as 

also provides information about appropriate or obstacle free 

path. We are using buzzer and vibrator, two output modes to 

user. It is important to develop this application for the future. In 

[2], paper, the study about a blind assistive and tracking 

embedded system. The blind person is navigated through a 

spectacle interfaced with an android application. The blind 

person is guided through Bengali and English voice commands 

generated by the application according to the obstacle position. 

Using voice command a blind person can establish voice call to a 

predefined number without touching the phone just by pressing 

the headset button. The system has been tested through several 

test cases. The blind assistive device with Eye mate for Blind 

android application is very useful for a blind person to move 
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without the help of other and the user can seek emergency help 

through voice call. The tracking system involved here through 

Blind Tracker application is very applicable to track the current 

location of the blind person. This smart stick comes as a solution 

to enable visually impaired people to find difficulties in detecting 

obstacles and dangers in front of the blind people during walking 

and to identify the world around. The system consists of various 

sensors along with Arduino Uno microcontroller and the GPS 

GSM. Microcontroller receives the sensor signals and processes 

them to short pulses to the Arduino pins where buzzers and 

vibrator are connected, which get starts if the obstacle finds in 

the way. GPS and GSM technology helps for tracking the device 

is studied in [3]. In [4], proposed third type of aid that detects 

obstacles in his path ahead using ultrasonic waves on sensing 

obstacles passes this data to the microcontroller. The 

microcontroller then processes this data and calculates if the 

obstacle is close enough. If the obstacle is not that close the 

circuit does nothing. If the obstacle is close to the 

microcontroller sends a signal to sound a buzzer and produces 

appropriate alerts to save the person from hitting obstacles. The 

stick is generated using many sensors like Ultrasonic, Flame 

sensor and Water sensor. When the blind person moves from one 

place to another place with the help of sensors the message is 

passed to the blind person through the Arduino UNO in the form 

of different types of beep and vibrations. Because of this stick 

blind people can move easily from one place to another without 

help of others and it also increase the autonomy for the blinds. In 

[5], the focus on visually impaired have to face many challenges 

in their daily life. The problem gets worse when they travel to an 

unfamiliar location. Only few of the navigation systems available 

for visually impaired people can provide dynamic navigation 

through speech output. None of these systems work perfectly for 

both indoor and outdoor applications. In this paper, they propose 

a navigation device for the visually impaired which is focused on 

providing voice output for obstacle prevention and navigation 

using infrared sensors, RFID technology, and android devices. It 

aims to solve the problems faced by the blind people in their 

daily life. The system also takes measures to ensure their safety.    

III. PROPOSED SYSTEM 

Normally, a blind person uses cane as guide to protect him from 

obstacles. Most of area of surrounding is covered by the cane, 

especially the area near to his legs like stairs etc. But certain 

areas such as near to his head, especially when he is entering or 

leaving the door which is short in height. This system is specially 

designed to protect the area near to his head. The product is 

designed to provide full navigation to user into the environment. 

It guides the user about obstacles as well as also provides 

information about appropriate or obstacle free path. We are 

using buzzer and vibrator, two output modes to user. 

The proposed system has Hardware, Android, GPS and web 

based system capable of assisting the blind and visually impaired 

without the help of sighted person. The proposed system detects 

obstacles in his path ahead using ultrasonic waves on sensing 

obstacles passes this data to the microcontroller. The 

microcontroller then processes this data and calculates if the 

obstacle is close enough. If the obstacle is not that close the 

circuit does nothing. If the obstacle is close to the 

microcontroller sends a signal to sound as a buzzer and produces 

appropriate alerts to save the person from hitting obstacles. 

 

 
Fig. 1: Proposed solution to navigate and track Blind person 

 

 
Fig.2 Block diagram of proposed design.  

 

(a). ARDUINO UNO 

Steps for connecting Arduino in IoT 

Step 1 – First Arduino board and USB cable. In case you use 

Arduino UNO, Arduino Duemilanove, Nano, Arduino Mega 

2560, or Diecimila, use a standard USB cable (A plug to B 

plug), the kind you would connect to a USB printer. 

Step 2 − Download Arduino IDE Software. 

You can get different versions of Arduino IDE from the 

Download page on the Arduino Official website. You must 

select your software, which is compatible with your operating 

system (Windows, IOS, or Linux). After your file download is 

complete, unzip the file. 

Step 3 − Power up your board. 

The Arduino Uno, Mega, Duemilanove and Arduino Nano 

automatically draw power from either, the USB connection to 

the computer or an external power supply. If you are using an 

Arduino Diecimila, you have to make sure that the board is 

configured to draw power from the USB connection. The 

power source is selected with a jumper, a small piece of plastic 

that fits onto two of the three pins between the USB and power 

jacks. Check that it is on the two pins closest to the USB port. 

Connect the Arduino board to your computer using the USB 

cable. The green power LED (labeled PWR) should glow. 

Step 4 − Launch Arduino IDE. 

After your Arduino IDE software is downloaded, you need to 

unzip the folder. Inside the folder, you can find the application 

icon with an infinity label (application.exe). Double-click the 

icon to start the IDE. 

Step 5 − Open your first project. 

Once the software starts, you have two options – 

http://www.jetir.org/
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Create a new project. 

Open an existing project example. 

To create a new project, select File → New. 

To open an existing project example, select File → Example 

→ Basics → Blink. 

Here, we are selecting just one of the examples with the name 

Blink. It turns the LED on and off with some time delay. You 

can select any other example from the list. 

Step 6 − Select your Arduino board. 

To avoid any error while uploading your program to the board, 

you must select the correct Arduino board name, which 

matches with the board connected to your computer. Go to 

Tools → Board and select your board. 

Here, we have selected Arduino Uno board according to our 

tutorial, but you must select the name matching the board that 

you are using. 

Step 7 − Select your serial port. 

Serial Port menu. This is likely to be COM3 or higher (COM1 

and COM2 are usually reserved for hardware serial ports). To 

find out, you can disconnect your Arduino board and re-open 

the menu, the entry that disappears should be of the Arduino 

board. Reconnect the board and select that serial port. 

 
Fig. 4 Serial port tools 

Step 8 − Upload the program to your board. 

Before explaining how we can upload our program to the 

board, we must demonstrate the function of each symbol 

appearing in the Arduino IDE toolbar. 

 
A − Used to check if there is any compilation error. 

B − Used to upload a program to the Arduino board. 

C − Shortcut used to create a new sketch. 

D − Used to directly open one of the example sketch. 

E − Used to save your sketch. 

F − Serial monitor used to receive serial data from the board 

and send the serial data to the board. 

Now, simply click the "Upload" button in the environment. 

Wait a few seconds; you will see the RX and TX LEDs on the 

board, flashing. If the upload is successful, the message "Done 

uploading" will appear in the status bar. 

 
 

Fig.3  ARDUINO UNO KIT 

 

 

Power USB 

Arduino board can be powered by using the USB 

cable from your computer. All you need to do is 

connect the USB cable to the USB connection (1). 

 

Power (Barrel Jack) 

Arduino boards can be powered directly from the 

AC mains power supply by connecting it to the 

Barrel Jack (2). 

 

Voltage Regulator 

The function of the voltage regulator is to control the 

voltage given to the Arduino board and stabilize the 

DC voltages used by the processor and other 

elements. 

 

Crystal Oscillator 

The crystal oscillator helps Arduino in dealing with 

time issues. How does Arduino calculate time? The 

answer is, by using the crystal oscillator. The number 

printed on top of the Arduino crystal is 16.000H9H. 

It tells us that the frequency is 16,000,000 Hertz or 

16 MHz. 

 

Arduino Reset 

You can reset your Arduino board, i.e., start your 

program from the beginning. You can reset the UNO 

board in two ways. First, by using the reset button 

(17) on the board. Second, you can connect an 

external reset button to the Arduino pin labelled 

RESET (5). 

 

Pins (3.3, 5, GND, Vin) 

3.3V (6) − Supply 3.3 output volt 

5V (7) − Supply 5 output volt 

Most of the components used with Arduino board 

works fine with 3.3 volt and 5 volt. 

GND (8)(Ground) − There are several GND pins on 

the Arduino, any of which can be used to ground 

your circuit. 

Vin (9) − This pin also can be used to power the 

Arduino board from an external power source, like 

AC mains power supply. 

 

Analog pins 

The Arduino UNO board has five analog input pins 

A0 through A5. These pins can read the signal from 

an analog sensor like the humidity sensor or 
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temperature sensor and convert it into a digital value 

that can be read by the microprocessor. 

 

Main microcontroller 

Each Arduino board has its own microcontroller 

(11). You can assume it as the brain of your board. 

The main IC (integrated circuit) on the Arduino is 

slightly different from board to board. The 

microcontrollers are usually of the ATMEL 

Company. You must know what IC your board has 

before loading up a new program from the Arduino 

IDE. This information is available on the top of the 

IC. For more details about the IC construction and 

functions, you can refer to the data sheet. 

 

ICSP pin 

Mostly, ICSP (12) is an AVR, a tiny programming 

header for the Arduino consisting of MOSI, MISO, 

SCK, RESET, VCC, and GND. It is often referred to 

as an SPI (Serial Peripheral Interface), which could 

be considered as an "expansion" of the output. 

Actually, you are slaving the output device to the 

master of the SPI bus. 

 

Power LED indicator 

This LED should light up when you plug your 

Arduino into a power source to indicate that your 

board is powered up correctly. If this light does not 

turn on, then there is something wrong with the 

connection. 

 

TX and RX LEDs 

On your board, you will find two labels: TX 

(transmit) and RX (receive). They appear in two 

places on the Arduino UNO board. First, at the 

digital pins 0 and 1, to indicate the pins responsible 

for serial communication. Second, the TX and RX 

led (13). The TX led flashes with different speed 

while sending the serial data. The speed of flashing 

depends on the baud rate used by the board. RX 

flashes during the receiving process. 

 

Digital I/O 

The Arduino UNO board has 14 digital I/O pins (15) 

(of which 6 provide PWM (Pulse Width 

Modulation) output. These pins can be configured to 

work as input digital pins to read logic values (0 or 

1) or as digital output pins to drive different modules 

like LEDs, relays, etc. The pins labeled “~” can be 

used to generate PWM. 

 

AREF 

AREF stands for Analog Reference. It is sometimes, 

used to set an external reference voltage (between 0 

and 5 Volts) as the upper limit for the analog input 

pins. 

The Arduino program structure and we will learn more new 

terminologies used in the Arduino world. The Arduino 

software is open-source. The source code for the Java 

environment is released under the GPL and the C/C++ 

microcontroller libraries are under the LGPL. 

Sketch − The first new terminology is the Arduino program 

called “sketch”. 

Structure 
Arduino programs can be divided in three main parts: 

Structure, Values (variables and constants), and Functions. In 

this tutorial, we will learn about the Arduino software program, 

step by step, and how we can write the program without any 

syntax or compilation error. 

Let us start with the Structure. Software structure consist of 

two main functions − 

Setup( ) function 

Loop( ) function 

 
Fig.5 shows sketch_Arduino 

 

Void setup ( ) { 

} 

PURPOSE − The setup() function is called when a sketch 

starts. Use it to initialize the variables, pin modes, start using 

libraries, etc. The setup function will only run once, after each 

power up or reset of the Arduino board. 

Void Loop ( ) { 

} 

After creating a setup() function, which initializes and sets the 

initial values, the loop() function does precisely what its name 

suggests, and loops consecutively, allowing your program to 

change and respond. Use it to actively control the Arduino 

board. 

 

(b) Ultrasonic Sensor 

This ultrasonic sensor module can be used for measuring 

distance, object sensor, motion sensors etc. High sensitive 

module can be used with microcontroller to integrate with 

motion circuits to make robotic projects and other distance, 

position & motion sensitive products. The module sends eight 

40Khz square wave pulses and automatically detects whether it 

receives the returning signal. If there is a signal returning,  a 

high level pulse is sent on the echo pin. The length of this pulse 

is the time it took the signal from first triggering to the return 

echo. Distance = (speed of sound × time take n) / 2. 

The HC-SR04 ultrasonic sensor uses SONAR to determine the 

distance of an object just like the bats do. It offers excellent 

non-contact range detection with high accuracy and stable 

readings in an easy-to-use package from 2 cm to 400 cm or 1” 

to 13 feet. The operation is not affected by sunlight or black 

material, although acoustically, soft materials like cloth can be 

difficult to detect. It comes complete with ultrasonic transmitter 

and receiver module. 
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Fig. 6Ultrasonic sensor 

 
Fig.7  

Technical Specifications 

Power Supply − +5V DC 

Quiescent Current − <2mA 

Working Current − 15mA 

Effectual Angle − <15° 

Ranging Distance − 2cm – 400 cm/1″ – 13ft 

Resolution − 0.3 cm 

Measuring Angle − 30 degree 

 
(c) Water sensor 

Water sensor / liquid level sensor it  brick is designed for water 

detection, which can be widely used in sensing rainfall, water 

level, and even liquid leakage. The sensor operates on 5V and 

needs less than 20mA for operating power current, which 

means the arduino can easily provide this (so no external power 

is needed to power it).  

The liquid level sensor has 3 pins. It's very basic. The pinout is 

shown below.  

 

Fig. 8.Water sensors 

The signal pin (S) gets connected to an analog pin on the 

arduino board. Here we connect it to analog pin A0. This 

allows the arduino board to be able to read the analog voltage 

value. 2 of the pins are for power, 1 connecting to the +5V of 

the arduino and the other connecting to the ground terminal of 

the arduino. The other pin, with an S, is the signal pin. This is 

the pin that outputs the analog voltage signal in proportion to 

the amount of the sensor which is covered with liquid. This pin 

connects to an analog pin on the arduino board to be read. 

Connecting a water sensor to an Arduino is a great way to 

detect a leak, spill, flood, rain, etc. It can be used to detect the 

presence, the level, the volume and/or the absence of water. 

While this could be used to remind you to water your plants, 

there is a better Grove sensor for that. The sensor has an array 

of exposed traces, which read LOW when water is detected. 

4.5 flame sensor 

A Flame Sensor is a device that can be used to detect presence 

of a fire source or any other bright light sources. There are 

several ways to implement a Flame Sensor but the module used 

in this project is an Infrared Radiation Sensitive Sensor. 

The following image shows an Infrared type Flame Sensor. 

 
This particular flame sensor is based on YG1006 NPN Photo 

Transistor. The black object at the front of the module is this 

Photo Transistor. 

The YG1006 Photo Transistor looks like a black LED but it is 

a three terminal NPN Transistor, where the long lead is the 

Emitter and the shorter one is the collector (there is no base 

terminal as the light it detects will enable the flow of 

current).This photo transistor is coated with black epoxy, 

making it sensitive to  

 

Infrared radiations and this particular Photo Transistor 

(YG1006) is sensitive to Infrared Radiation in the wavelength 

range of 760nm to 1100nm. Using this particular type of Flame 

Sensor, you can detect Infrared Light up to a distance of 100cm 

within its 60 degrees of detection angle. 
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There are two types of implementations of Flame Sensors using 

YG1006 Photo Transistor: one is with both Analog Output and 

Digital Output while the other is with only the Digital Output. 

Both these implementations require same components but the 

difference is that one module (the one with the Analog Output) 

provides the Sensor output as Analog Output. 

The following image shows all the components of a typical 

Flame Sensor Module. 

4.6 Infrared Sensor 

An infrared sensor is an electronic device, that emits in order to 

sense some aspects of the surroundings. An IR sensor can 

measure the heat of an object as well as detects the 

motion.These types of sensors measures only infrared 

radiation, rather than emitting it that is called as a passive IR 

sensorUsually in the infrared spectrum, all the objects radiate 

some form of thermal radiations. These types of radiations are  

invisible to our eyes, that can be detected by an infrared 

sensor.The emitter is simply an IR LED (Light Emitting Diode) 

and the detector is simply an IR photodiode which is sensitive 

to IR light of the same wavelength as that emitted by the IR 

LED. When IR light falls on the photodiode, The resistances 

and these output voltages, change in proportion to the 

magnitude of the IR light received. 

 
Principle of Working 

The principle of an IR sensor working as an Object Detection 

Sensor can be explained using the following figure. An IR 

sensor consists of an IR LED and an IR Photodiode; together 

they are called as Photo – Coupler or Opto – Couple.When the 

IR transmitter emits radiation, it reaches the object and some of 

the radiation reflects back to the IR receiver. Based on the 

intensity of the reception by the IR receiver, the output of the 

sensor is defined. 

 

IV. EXPERIMENTAL RESULTS AND DISCUSSIONS  

 

 
 

V. CONCLUSION 
the concept of Smart Stick for Blind People. It 
includes the detection of obstacles while blind 
people moves from one place to another place. 
The stick is generated using many sensors like 
Ultrasonic, Flame sensor and Water sensor etc. 
When the blind person moves from one place to 
another place with the help of sensors the 
message is passed to the blind person through 
the Arduino UNO microcontroller in the form of  
different types of beeps and vibration. The 
triggers are generated from the sensors if any 
danger or inconvenience is there. That trigger is 
passed to the microcontroller and it passes the 
alerts to the blind person through the beep 
message and vibration which are connected to 
the smart stick. Because of this stick blind people 
can move easily from one place to another 
without help of others and it also increase the 
autonomy for the blind.  
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